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Welcome to the Hyperion Analyzer Installation Guide for UNIX. This preface
discusses the following topics:

« “Purpose” on page vii

« “Audience’ on page vii

« “Document Structure” on page viii

« “Product Documentation” on page viii

« “Whereto Find Documentation” on page ix
. “Conventions’ on page Xi

. “Additional Support” on page xii

Purpose

The Hyperion Analyzer Installation Guide explains product conventions, features,
and options, and it contains the concepts, processes, procedures, formats, tasks,
and examples that you need to install Hyperion Analyzer.

Audience

Although this guideis intended for system and application administrators
responsible for installing, configuring, and maintaining Hyperion Analyzer,
advanced users will also benefit from the procedures and conceptual information.
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Preface

Document Structure

This document contains the following information:

Chapter 1, “Hyperion Analyzer Overview,” introducesthe Hyperion Analyzer
product and the components of the application. The chapter also provides an
overview of the architecture and the installation options you have.

Chapter 2, “Installing Hyperion Analyzer on UNIX,” lists the system
requirements for the server, the stand-alone client, and the client as are the
installation procedures to install Hyperion Analyzer in a UNIX operating
environment.

Chapter 3, “What's Installed?,” examines the directory structure of Hyperion
Anayzer to provide a descriptive overview of the directory contents. This
facilitates|ocating configuration files, documentation, and application folders
and files.

Chapter 4, “Deploying Hyperion Analyzer into IBM WebSphere,” provides
specific instruction on installing Hyperion Analyzer into an existing IBM
WebSphere application server.

Chapter 5, “Deploying Hyperion Analyzer to BEA WebLogic,” provides
specific instruction on installing Hyperion Analyzer into an existing BEA
WebL ogic application server.

Chapter 6, “ Creating Repositories with Scripts,” contains the procedures to
create the database repositories and the required tablesin the databases for al
supported RDBMSS systems.

Chapter 7, “Importing Hyperion Analyzer Sample Reports,” furnishes the
procedures to import Hyperion Analyzer and API Toolkit sample reports
through the Java Web Client.

Chapter 8, “Uninstalling Hyperion Analyzer,” contains the procedure to
uninstall Hyperion Analyzer from your UNIX operating system.

Product Documentation

viii |

Information Map

The Hyperion Analyzer Information Map lists and describes all Hyperion
Analyzer documentation and its location.
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Preface

[l Todisplay the information map:
1. Perform one of the following:

« Fromthe Hyperion Analyzer Launch Page, click the I nformation Map
link.

« From abrowser window, enter the following URL:
http://<server>/Hel p/ en/ | nformati onMap/i nformati on_nmap. ht m

Getting Started

Hyperion Analyzer Getting Sarted gives an overview of Hyperion Analyzer,
relates terminology central to multidimensional analysis, explains application
fundamental s and graphical user interfaces, and leads you through the creation of
your first report using the Hyperion Analyzer Java Web Client.

New Features

Hyperion Analyzer New Features describes al new features specific to this
release.

Client Online Help

Java Web Client Online Help

The Hyperion Analyzer Java Web Client Online Help provides detailed
information about navigation, report creation, and advanced Java Web Client
topics.

HTML Web Client Online Help

The Hyperion Analyzer HTML Web Client Online Help provides detailed
information about navigation, report creation, and the features specific to the
HTML Web Client.

Where to Find Documentation

All Hyperion Analyzer documentation is accessible from the following locations:
« TheHTML Information Map islocated at:

Hyperion Analyzer Installation Guide for UNIX B X



Preface

http://<server>/Hel p/ en/Informati onMap/i nformati on_map. ht m

« Online help is accessible from the user interface that it documents. Start the
product and click the Help button or menu command.

« TheHyperion SolutionsWeb siteislocated at ht t p: / / www. hyperi on. com

To access the documentation from the Hyperion Solutions Web site:
1. Logontohttp://ww. hyperion.com.
2. Select Support from the menu bar.

3. Enter your username and password, and click L ogin.

Note: If you do not have a username and password, click New User Registration on
the left side of the login page to request them.

4. Select Order/Download Documentation.
5. From the Product list box, select Hyperion Analyzer.
6. From the Display list box, select Documentation, then click Submit.

To access the documentation from the Hyperion Download Center:
1. Logontohttp://hyperion.subscribenet.com.

2. IntheLogin I D and Password text boxes, type your assigned login ID and
password. Then click Login.

3. If youareamember on multiple Download Center accounts, sel ect the account
that you want to use for the current session.

4. FromtheProduct List, select Hyperion Analyzer.
Inthe New Releases tab, select Hyperion Analyzer 6.5.
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Conventions

The following table shows the conventions used in this document:
Table i: Conventions Used in This Document

Item Meaning

> Arrowsindicate the beginning of aprocedure consisting of
sequential steps or a one-step procedure.

Brackets|[] In examples, brackets indicate that the enclosed elements
areoptional.

Bold Bold in procedural steps highlights major interface
elements.

CAPITAL LETTERS | Capitd |etters denote commands and various IDs.
(Example: CLEARBLOCK command)

Ctrl +0 Keystroke combinations shown with the plus sign (+)
indicate that you should press thefirst key and hold it
while you press the next key. Do not type the + sign.

Exanpl e t ext Courier font indicates that the material shown isacode or
syntax example.

Courieritalics Courier italic text indicates a variable field in command
syntax. Substitute avalue in place of the variable shownin
Courier italics.

ARBORPATH When you see the environment variable ARBORPATH N
italics, substitute the value of ARBORPATH from your site.

Italics Italicsin a product-related term in the body of a book
indicates that the term is also included in the glossary of
the book.

n, X Italic n stands for a variable number; italic x can stand for
avariable number or an alphabet. These variables are
sometimes found in formulas.

Ellipses(...) Ellipsis points indicate that text has been omitted from an
example.
Mouse orientation This document provides examples and procedures using

aright-handed mouse. If you use aleft-handed mouse,
adjust the procedures accordingly.
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Table i: Conventions Used in This Document (Continued)

Item Meaning

Menu options Optionsin menus are shown in the following format.
Substitute the appropriate option names in the
placeholders, as indicated.

Menu name > Menu command > Extended menu
command

For example: 1. Select File > Desktop > Accounts.

Additional Support

In addition to providing documentation and online help, Hyperion offers the
following support for product information.

How to Order Printed Documentation
To order printed documentation use one ofthe following methods:
« Visit the Hyperion Solutions Web site at ht t p: / / www. hyperi on. com.

« Inthe United States, call Hyperion Solutions Customer Support at
877-901-4975.

« From outside the United States, including Canada, call Hyperion Solutions
Customer Support at 203-703-3600. Clients who are not serviced by support
from North America should call their local support centers.

Education Services

Hyperion offers a variety of training options, including instructor-led training,
custom training, and eTraining. This education covers all Hyperion applications
and technologies and is geared to administrators, end users, and information
systems (IS) professionals.

Instructor-led training isdelivered in formats and in locations suited to Hyperion's
diverse, global customers. Hyperion Authorized Training Centers are certified to

deliver courses developed by Hyperion. Custom Education Services—training on
the configured and tailored applicationsthat employees use on the job—is another
option to enhance user productivity and to ensure smooth day-to-day operations.

A service called eTraining—including computer-based training, Web-based
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training, and interactive Virtual Classroom training—provides a cost-effective
means of giving you a hands-on introduction to product features and functions.
Computer-based training (CBT) and Web-based training (WBT) provide
high-quality, self-paced training at the user’s convenience, regardless of location.

For more information about training, contact your Regional Education Manager
or visit the Hyperion Solutions Web site at ht t p: / / www. hyper i on. comto see
alist of all training classes.

Consulting Services

Hyperion Consulting Services assists customersin maximizing the use of, and the
return on investment in, Hyperion products. Experienced Hyperion consultants
and Hyperion Alliance Partners assist organizations in tailoring solutions to their
particular requirements, such as reporting, analysis, modeling, and planning.
Specific services include implementation consulting, custom business solutions,
dataintegration, and technical consulting. Additionally, Hyperion offers avariety
of Services Packages and Reviews.

For more information about Consulting Services, Services Packages and
Reviews, and including the services offered by Alliance Partners, contact your
local consulting services representative, or visit the Hyperion Solutions Web site
athttp://ww.hyperion. comtoseealist of all Hyperion Alliance Partners.

Technical Support

Hyperion provides Web-based and tel ephone support to ensure that clientsresolve
product issues quickly and accurately. This support is available for al Hyperion
products at no additional cost to clients with a current maintenance agreement.

« For Web-based support, or to see complete information on
available support options, visit the Hyperion Solutions Web site
ahttp://ww. hyperion.com

« Inthe United States, call 877-901-4975 for Hyperion Solutions Customer
Support.

« From outside the United States, including Canada, call Hyperion Solutions
Customer Support at 203-703-3600. Clients who are not serviced by support
from North America should call their local support centers.

Hyperion Analyzer Installation Guide for UNIX B Xiii
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Documentation Feedback

Hyperion strives to provide complete and accurate documentation. We value
your opinions on this documentation and want to hear from you. Send us your
comments by completing the survey available at ht t p: / / www. hyperi on. com.

Xiv | Hyperion Analyzer Installation Guide for UNIX
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Hyperion Analyzer Overview

Hyperion Analyzer consists of the following components:

Repository: A central storage location for Hyperion Analyzer system data,
user IDs, user preferences, and report definitionsin relational database tables.

Hyperion Analyzer Analysis Server: A servlet-based Web application that
resides within the J2EE application server. The Analysis Server facilitates the
rendering of reportsto either the HTML or Java clients and provides
Web-based user management.

Hyperion Analyzer Administration Tools: A client that provides a Java
graphical interface for managing users, users groups, and database
connections using a supported Web browser. It aso provides accessto severa
administration utilities.

Hyperion Analyzer Java Web Client: A client that enables online analysis
of data. You can design and format custom analysis applications without
“coding.” Hyperion Anayzer is commonly used to conduct sales, key
performance, and financial and forecasting analyses.

Hyperion Analyzer Windows Client: A Java Web client interface and
functionality delivered as a Java application for supported Microsoft
Windows operating systems.

Hyperion Analyzer HTML Web Client: An HTML thin client used by way
of asupported Web browser. It is engineered for information consumers who
do not require advanced design and content-creation capabilities.

Hyperion Analyzer API Toolkit: A tool that developers can use to
incorporate the Hyperion Analyzer Java Web Client look and feel and
functionality into their own custom Web applications.

Hyperion Analyzer Installation Guide for UNIX m 15



Architectural Overview
Hyperion Analyzer functionality is distributed across a multitiered architecture:
o Clienttier
o  Servertier

o Databasetier

Figure 1: Architectural Diagram of Hyperion Analyzer Functionality
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The client tier comprises the three Web browser clients and the API Toolkit. All
clients communicate with the rest of the Hyperion Analyzer system using
Hypertext Transmission Protocol (HTTP).

The server tier includes the following components:

o TheWeb server

« The J2EE application server

« TheHyperion Analyzer Analysis Server

« Driversand protocols for communicating with the database server layer

The database tier supports OLAP and relational databases, and the relational
Hyperion Analyzer repository. Data source connectivity to Hyperion Finacial
Management and Hyperion Planning is also available.

A supported Web server is required to present the Web page from which Web
clients are launched, to deliver files containing Java components, and to transport
images generated at run time. After clients are established, the Web server
manages all client mid-tier HTTP communication.

Hyperion Analyzer runsinside a J2EE application server. The supported J2EE
application server shares Hyperion Analyzer business logic, network traffic,
application security for large numbers of concurrent users, and they provide load
balancing and fault tolerance.

Through the installation process, Hyperion Analyzer is deployed into a J2EE
application server, and Hyperion Analyzer tables are created on the RDBM S
selected repository option. The system leverages a Web server to communicate
with clients.

Hyperion Analyzer Installation Guide for UNIX m 17



Deployment Options

Hyperion Analyzer provides agreat dea of flexibility in the way you can
configure the system. Configuration options are determined by several factors.
Among other considerations, the following list includes some possible
considerations for making deployment decisions:

«  Current hardware and software

« Future hardware and software upgrades

« Quantity of data

« The balance between ease of configuration and performance

In an effort to assist you in your decision-making, Hyperion recommends
examining the following deployment options:

“Deployment Option 1" on page 19
“Deployment Option 2" on page 20
“Deployment Option 3" on page 20
“Deployment Option 4" on page 22
“Windows Stand-Alone Client Option” on page 22
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Deployment Option 1

Thefirst deployment option supports medium to large configurations. In this
instance, the Web server and application server are on the same computer and are
separatefromthe RDBM Srepository and data sources. Thisisthe most typical and
highly recommended configuration option. The separation of the components
allows for high scalability, and each hardware component can be upgraded
individually as needed.

Figure 2: Hyperion Analyzer Deployment Option 1
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Deployment Option 2

This configuration establishes the Web server, application server, and RDBMS
repository on same computer and separate from the data sources. This
configuration option is used for medium-size deployments.

Figure 3: Hyperion Analyzer Deployment
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The third option is intended to support

Any 05 (Excent HFRY o

alarge enterprise system with an existing

systemic structure that Hyperion Analyzer can integrate into and leverage. The
Web server and application server are on separate computers, as are the RDBM S
repository and data sources. Thisisthe typical configuration option for an
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enterprise with a centralized Web server farm. However, this configuration
requires more in depth knowledge of Web server and application server
configuration.

Figure 4: Hyperion Analyzer Deployment Option 3
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Deployment Option 4

Theforth option is best utilized for asmall deployment, testing and prototype
situations. The Web server, application server, Essbase/Hyperion Financial
Management and RDBM S Repository areal on the same server. Thisoptionisnot
recommended for high concurrent usage, unless the servers have multiple CPUs
and maximized availability of RAM.

Figure 5: Hyperion Analyzer Deployment Option 4
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Windows Stand-Alone Client Option

Included in each of the deployment options depicted previously, is the option of
implementing a stand-al one client in the Windows operating environment. This
option provides TCP/IP connectivity to the Hyperion Analyzer repository,
RDBMS, and OL AP data sources without the use of a Web and application
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servers. The drawback to this option is the required JDBC drivers and Hyperion
Esshase client. This adds to the complexity of the deployment over the ssimpler,
html-based thin client and java applet.

Installation Options

You can install Hyperion Analyzer using any of the following procedures:

Microsoft Windows Installation: Theset up. exe installation fileis provided
for those installing Hyperion Analyzer on Microsoft Windows operating
systems. You have the option of installing to the Apache Tomcat 4.1.x
application server, an existing Apache Tomcat 4.0.4 or later, IBM
WebSphere, or BEA WebL ogic application server. Refer to the Hyperion
Analyzer Installation Guide for Windows section for more information.

UNIX operating system: Hyperion provides set up_ai x. sh,

set up_hpux. sh, and set up_sol ari s. sh shell scriptsfor installing
Hyperion Analyzer Analysis Server on either the IBM AlX, HP-UX, or Sun
Solaris UNIX operating systems. Depending on the opertaing system you are
using, you have the option of installing to the Apache Tomcat 4.1.x
application server, an existing Apache Tomcat 4.0.4 or later, IBM WebSphere,
or BEA WebL ogic application server. See Chapter 2, “Installing Hyperion
Anayzer on UNIX,” for more information.

Manual deployments to application servers. You can deploy Hyperion
Anayzer manually to severa application serversif you prefer not to use the
provided application server. The following options are available:

— IBM WebSphere installation: You must manually deploy Hyperion
Analyzer into a previoudly installed application server. See Chapter 4,
“Deploying Hyperion Analyzer into IBM WebSphere” section for more
information.

— BEA WebLogic installation: You must manually deploy Hyperion
Anayzer into aprevioudly installed application server. See Chapter 5,
“Deploying Hyperion Analyzer to BEA WebL ogic,” for more
information.
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Installing Hyperion Analyzer
on UNIX

This chapter outlines all the prerequisites, requirements, and procedures for
installing Hyperion Anayzer on a supported UNIX operating system. The
following sections will assist you in the process:

« “System Requirements’ on page 25

. ‘“Beforelnstalling Hyperion Analyzer” on page 29

« ‘“Instalation Summary” on page 31

« “Instaling Hyperion Analyzer” on page 32

o “After Installing Hyperion Analyzer” on page 47

. “Starting the Hyperion Essbase OLAP Server” on page 50

System Requirements

This section outlines the prerequisites needed for installing Hyperion Analyzer on
UNIX. Your installation must satisfy the following genera and
application-specific system requirements.

Server System Requirements

Table 2: Hyperion Analyzer Server System Requirements

Component Requirement

Processor 450 MHz CPU

Memory 512 MB RAM

Disk Space 1 GB of processing space

Hyperion Analyzer Installation Guide for UNIX m 25



Table 2: Hyperion Analyzer Server System Requirements(Continued)

Component

Requirement

Operating System

One of the following Operating Systems:
e Sun Solaris5.8
« IBMAIX 433

e HP_UX 11i
Web browser One of the following browsers:
e Microsoft Internet Explorer 5.5 or 6.0
* Netscape Navigator 6.2 or 7.0
Javaplugin 1.3.0 020r1.3.1 07
Spreadsheet Microsoft Excel 97 (spl or 2), 2000 or XP
add-ins
Peripherals «  SVGA monitor, 800x600 resolution
¢ CD-ROM drive
Network TCP/IP
connection
Application One of the following servers:
Servers » Tomcat 4.0.4
e Tomcat 4.1.18 (full installation provided)
e |BM WebSphere 4.0.5 Advanced Edition, or Advanced
Edition Single Server
* IBM WebSphere 5.0, Express, or Enterprise Edition
* BEA WebLogic 6.1.4 (Service Pack 3 is supported)
* BEA WebLogic 7.0
OLAP servers One of the following servers:
e Hyperion Esshase 6.2.4 or 6.5.4
* |BM DB2 OLAP Server 7.1 (FixPak 11)
e |BM DB2 OLAP Server 8.1 (FixPak 2)
Relational data Hyperion Financial Management 3.0.3 or 3.0.4
sources

Hyperion Planning 3.3
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Table 2: Hyperion Analyzer Server System Requirements(Continued)

Component

Requirement

Relational servers

One of the following servers:

« |IBM DB2 7.2 Enterprise Personal Edition (full installation
provided), JDBC 2.0

e |IBM DB2 8.1 Enterprise Server Edition

¢ Microsoft SQL Server 2000, SP3, MS SQL Server JDBC
drivers

¢ Oracle8.1.7 or 9.2.1, Native JDBC drivers
¢ Teradata4.1l

Other

* Applicable Hyperion Essbase Runtime client
¢ Adobe Acrobat Reader 5.0

Stand-Alone Client System Requirements

Table 3: Hyperion Analyzer Stand-Alone Client System Requirements

Component Requirement

Processor 450 MHz CPU
Memory 256 MB RAM
Disk space 25MB

Operating system

One of the following operating systems:

* Microsoft Windows NT 4.0, Service Pack 6a
¢ Microsoft Windows 2000, Service Pack 3

* Microsoft Windows XP

Web browser for One of the following browsers:

Web client » Microsoft Internet Explorer 5.5 or 6.0
* Netscape Navigator 6.2 or 7.0

Web browser for One of the following browsers:

Javaclient

e Microsoft Internet Explorer 4, 5, or 6
» Netscape Navigator 4.7, 6.1, or 6.2
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Table 3: Hyperion Analyzer Stand-Alone Client System Requirements(Continued)

Component

Requirement

Javaplugin for

Sun JavaPlug-in 1.3.0 02 or 1.3.1 07

Javaclient Note: Installed automatically on first use of Hyperion
Analyzer.

Relational One of the following repositories:

repositories « 1BM DB2 7.2 Enterprise Personal Edition, JDBC 2.0
e |IBM DB2 8.1 Enterprise Server Edition, JDBC 2.0
» Microsoft SQL Server 2000, SP3, MS SQL JDBC
e Oracle8.1.70r9.21

Other » Applicable Hyperion Essbase Runtime client

Note: To access Hyperion Essbase, the corresponding
Hyperion Essbase Runtime client must be installed with the
J2EE Application Server.

* Adobe Acrobat Reader 5.0

Client System Requirements

Table 4: Hyperion Analyzer Client System Requirements

Component Requirement

Processor 450 MHz CPU
Memory 512 MB RAM
Disk space 25MB

Operating system

One of the following operating systems:

e Microsoft Windows NT 4.0, Service Pack 6a
» Microsoft Windows 2000, Service Pack 3

e Microsoft Windows XP

Web browser for
Web client

One of the following browsers:
* Microsoft Internet Explorer 5.5 or 6.0
» Netscape Navigator 6.2 or 7.0
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Table 4: Hyperion Analyzer Client System Requirements(Continued)

Component Requirement
Web browser for One of the following browsers:
Javaclient

* Microsoft Internet Explorer 4, 5, or 6
» Netscape Navigator 4.7, 6.1, or 6.2

Javaplugin for

Sun JavaPlug-in 1.3.0 02 or 1.3.1 07

Javaclient Note: Installed automatically on first use of Hyperion
Analyzer.
Other Adobe Acrobat Reader 5.0

Before Installing Hyperion Analyzer

Prior to installing Hyperion Analyzer, there are anumber of prerequisite tasks and
considerations to execute at |east examine for applicability to your situation. The
following sections cover this information:

« “Preinstallation Checklist” on page 29
« “RDBMS Considerations’ on page 30

« “Backing Up an Existing Repository” on page 31

Preinstallation Checklist

Complete the following tasks that apply to your installation situation prior to
installing Hyperion Analyzer:

o Whenyou install Hyperion Analyzer on a UNIX operating system, you must
install the software using the XWindows user interface.

« Itisrecommended that you not use spaces in path names and location

descriptions.

« Review the system requirements for your configuration and ensure

compliance.

« If thereisaprevious release of Hyperion Analyzer on the system, create a
backup of the Hyperion Analyzer repository. For more information see,
“Backing Up an Existing Repository” on page 31.
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« Verify the server names and pathnames. Do not use the name “localhost” to
identify servers.

« Ensurethe availability of usernames and passwords for your Hyperion
Essbase OLAP server and your RDBMS.

Note: The name “System” cannot be used for logon accounts. Duplicate logons
and passwords cannot be used. Ensure that your unique logons do not exceed
eight (8) characters in length.

« Ensurethat the correct JIDBC drivers are available for the RDBMS repository

you are using.

« If apreinstalled Apache Tomcat application server isused, ensurethat it is
stopped.

« If apreinstalled RDBMS system is being used, ensure that the serviceis
started.

RDBMS Considerations

IBM DB2 Version 7.2

When using IBM DB2 7.2 astherelational repository for Hyperion Analyzer, you
must configure DB2 to use JDBC 2.0 drivers and ensure that the following
repository types comply as required:

« Enterprise Personal Edition
« Enterprise Server Edition

[1 To configurethe DB2 RDBMSto use JDBC 2.0 drivers:
1. Stop al database services.
2. Runusej dbc2. bat onthesql I'i b\j aval2 subdirectory.

Note: When configuring the JDBC drivers for IBM DB2 8.1, ensure that the
db2jcc.jar file is in the same directory as the db2java.zip file.
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3. Restart all database services.

Note: When installing the Hyperion Analyzer repository on an existing DB2
database, you must provide a username and the database information to complete
the installation. The username given must have been previously assigned to the
database.

Enterprise Server and Personal Edition

« Enter the case-sensitive database server name when specifying locations and
paths. “Localhost” is not arecommended server name.

« Usernames are restricted to eight (8) characters or less.

IBM DB2 Enterprise Server Edition Only
« Ensurethat usernames are granted connection privileges to the database.

« Ensurethe database and ausername are created prior to installation in order to
create the RDBM S repository.

Oracle
« A Root logonisrequired for creating atablespace in Oracle.

« Usethe case-sensitive tablespace server name when specifying locations and
paths. “Localhost” is not arecommended server name.

« Donot createthe tablespace or the username prior to installation. Theinstaller
creates the both inside the database.

Backing Up an Existing Repository

The database tables in the Hyperion Analyzer repository have been reorganized.
During the installation, the tables are migrated to the new structure. Before
begining the installation, you must back up your existing repository. Asaresult of
the table changes, previous releases of Hyperion Analyzer repository do not work
with this release of Hyperion Analyzer.

Installation Summary

Toinstall Hyperion Analyzer successfully, you must complete the following tasks:
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« Select aninstallation language.

« Select ausage mode and setup type.

« Review the terms of the license agreement.
« Select and configure the application server.
« Select and configure the RDBMS.

« Configure Hyperion Analyzer.

« Review the summary of the installation.

« Completetheinstallation.

« Configure the software for your system.

Installing Hyperion Analyzer

32 .

The following procedure guides you through the process of installing Hyperion
Anayzer.

Note: During the installation of Hyperion Analyzer, progress through the windows by
clicking the Previous or Next button. To exit the installation, click the Exit button.

[l Toinstall Hyperion Analyzer:
1. Take one of the following actions:

« If you have the Hyperion Analyzer CD, insert the CD in your CD-ROM
drive.

« If you downloaded the Hyperion Analyzer software from an FTP site or
the Hyperion Download Center, take one of the following actions:

— Navigate to the directory where you downloaded the installation
application and double-click <shel | scri pt >.

— Onthe XWindows desktop, from aterminal window, type the
<dri ve>:/<pat h>/<shel | script>andclick OK.

Where <drive> and <path> are the location of the Hyperion Analyzer
installation application.Where <shell script> is one of the following
scripts:

e ./setup_aix.sh

e ./setup_hpux.sh
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e ./setup_solaris.sh

The Select a Language window is displayed.

Figure 6: The Select Language Window

Hyperion &nalyzer 6.5.0.0.00698 ==

08
o o Hyperionr

Select a Language

NP ® English
Welcome
Usage Mode ) Japanese

License Agreement & German
Select Application Server
Configure Application Server ) French 'i

Select ROBMS Repasitary W‘ﬁ

Configure RDBMS Repositary

Specify Relational Connectivity

Configure Hypetion Analyzer \ ./
Summary S

Perfarm Install %Q 4

Setup Complete ¥
s *

2. Select alanguage in which to display the installation wizard, then click Next.
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The Welcome window is displayed.

Figure 7: Hyperion Analyzer Installation Welcome Window

Hyperion Analyzer 6.5.0.0.00698 ==

800
o o Hyperion

Language

Welcome

Lzage Mode

License Agreement

Select Application Server
Configure Application Server
Select RDBEMS Repository
Configure RDEBMS Repository
Specify Relational Connectivity
Canfigure Hyperian Analyzer
Summary

Ferform Install

Setup Complete

Hyperion Analyzer Installer

R i
[
Welcome to Hyperion Analyzer. This wizard will guide you through the insta

and configuration process. X
b

\

1

3. Click Next.
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The Usage Mode window is displayed.

Figure 8: Hyperion Analyzer Installation Usage Window

Hyperion Analyzer 6.5.0.0.00698 =]

L 4
8°8 Hyperion’

Enter Your License Infermation

Language

® Evaluation

Welcome

Usage Mode 3 Licensed \
License Agreement )

Select Application Server | "‘
Configure Application Server -t | ' ,

" :.'_\:ﬁ ¥ i
Select RDEME Repository ]

Configure RDEMS Repository

Specify Relational Connectivity

Configure Hyperian Analyzer \‘ ;

Summary P .E
-

Perfarm Install

Setup Complete

Cancel Back Next

4. Select one of the following usage types:
. Toingal atrial version of Hyperion Analyzer, select Evaluation.

. Toinstal alicensed version of Hyperion Analyzer, select Licensed and
then enter avalid license key.

Note: Your license key is provided on the Hyperion Download Center at
http://hyperion. subscri benet.com

5. Click Next.
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The License Agreement window is displayed.

Figure 9: Hyperion Analyzer Installation License Agreement Window

Hyperion Analyzer 6.5.0.0.00698 )
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any further.

If, however, no such Sofware License Agreement has been executed between
following software license agreement ("Agreement") shall apply.

[The Agreement forms a leal agreement between Licensee, either an individual
Hyperion far the "Hyperion Analyzer" Product(s) ("Software") identified on the Pr
izsued to Licensee by Hyperion. By installing, copying, ar otherwise using the 5
agrees to he bound by the terms ofthis Agreement. Ifyou do not agree to the tel
do notinstall or use the Software Productis).

1. DEFIMITIONS
(a) "Documentation” means, collectively, the operation instructions, user manu

1

[*]

HYPERION SOLUTIONS CORPORATION SOFTWARE LICENSE AGREEMENT |=|

IMPORTANT-READ CAREFULLY: Ifthis Software has been acouired under an e;

<

rgchnical infarmation and materials, inwritten ar electronic form, provided by Hy|*|

@ | Disagree | Agree

Next

6. After reviewing the license agreement, select | Agree, then click Next.
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The Select Application Server Type window is displayed.

Figure 10: Hyperion Analyzer Installation Select Application Server Type Window

Hyperion Analyzer 6.5.0.0.00698 =10 x|
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o o Hyperion*

Select Application Server Type

i ) Tomeat 4.1
Welcome
Usage Mode [¥l Install Tomeat 4.1.18
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Select Application Server
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Configure ROBMS Repository

21 IBM WehSphere 4

) IBM WehSphere &
Specify Relational Connectivity

Configure Hyperion Analyzer ) webLogic 6.1
Summary
Petfartn Install ) ¥ebLogic 7.0

Setup Complete

7. Select one of the following application server options:

« Tomcat 4.1 — Installs Hyperion Analyzer to an existing Apache Tomcat
4.1 application server.

— Optional: Select to Install Tomcat 4.1.18. If you do not yet have an
application server installed, Apache Tomcat 4.1.18 and Hyperion
Anayzer areinstalled as part of the “ batteries included” option.

« Tomcat 4.0 — Installs Hyperion Analyzer to an existing Apache Tomcat
4.0.4 application server.

« |IBM WebSphere 4 —Installs Hyperion Analyzer to an existing IBM
WebSphere 4.0.5 application server.

« |IBM WebSphere5 —Installs Hyperion Analyzer to an existing IBM
WebSphere 5 application server.
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« WaebLogic 6.1 Installs Hyperion Analyzer to an existing BEA
WebL ogic 6.1 application server.

« WaebLogic 7.0 — Installs Hyperion Analyzer to an existing BEA
WebL ogic 7.0 application server.

Note: The HP-UX operating system only supports the Apache Tomcat 4.0 and 4.1

application server options.

8. Select Next.

The Configure Application Server window is displayed, as shown in
Figure 11. Three application servers, two versions of each, are supported by

Hyperion Analyzer.

Figure 11: Configure Application Server: Apache Tomcat 4.1.x (Default)

Hyperion Analyzer 6.5.0.0.00698

800
o o Hyperion*

—Iolx|
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Welcome

Usage Mode
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Select Application Server
Configure Application Server
Select RDEMS Repositary
Configure RDEMS Repositary
Specify Relational Connectivity
Configure Hyperion Analyzer
Summary

Perform Install

Setup Complete

Configure Application Server

‘ieh Senver:

| Use Default

HTTF Fort Addr

[s0

Advanced

Back Hext
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9. Based on the application server option you selected, provide the following
settings:

Table 5: Application Server Configuration Settings

Application Server Settings

Apache Tomcat 4.1 1. From Web Server list, select Use Default or
Microsoft Internet Information Services (11S)

2. Enter an HTTP Port Address, 80 is the default.

3. Optional: Click Advanced to set Host Aliasto a
name that differs from the server name.

Apache Tomcat 4.10r | 1. Enter apath to the Application Server L ocation, or

4.0 (preinstalled) browse to the root directory by clicking the ellipses
(...) button.

2. Enter an HTTP Port Address; 80 is the default.

3. Optional: Click Advanced to set Host Aliasto a
name that differs from the server name.

IBM WebSphere4or5 | 1. Enter apath to the Application Server Location, or
(preinstalled) browse to the root directory by clicking the ellipses
(...) button.

2. Enter the case-sensitive Node Name of the server on
which you are installing Hyperion Analyzer.

3. Enter an HTTP Port Address; 80 is the default.

4. Enter the Installed Applications Path, or browse to
the root directory by clicking the Ellipses (...) button.

5. Optional: Click Advanced to set Host Aliasto a
name that differs from the server name.

BEA WebLogic6.10r | 1. Enter apathtothe Application Server Location, or
7.0 (preinstalled) browse to the root directory by clicking the Ellipses
(...) button.

2. Enter the case-sensitive Node Name of the server on
which you are installing Hyperion Analyzer.

3. Enter an HTTP Port Address; 80 isthe default.

Optional: Click Advanced to set Host Aliasto a
name that differs from the server name.
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10. Click Next.

The Select RDBM S Repository Type window is displayed, as shown in
Figure 12. You specify the relational database for your Hyperion Analyzer
repository here. You also specify whether a database, the repository, or both
areto be created.

Figure 12: Hyperion Analyzer Installation Select RDBMS Repository Type Window

Hyperion Analyzer 6.5.0.0.00693 ) =10 x|
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o o Hyperion
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Configure Application Server
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Select RDBMS Repository
Configure RDBMS Repository @ Oracle (8.1.7 or 8i)
Specify Relational Connectivity (Z) QL Server 2000

Canfigure Hyperian Analyzer
Summary
Ferform Install

Setup Complete
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11. Select an RDBM S Repository Type and select one of the optionslisted in

Table 6.

Note: As part of the “batteries included” option, if you do not have an Existing RDBMS,
select Install DB2 7.2 Personal Edition, Hyperion Analyzer installs the RDBMS and
creates a database and repository.

Table 6: Options for the Supported RDBMS

RDBMS Options
IBM DB27.2Personal |« CreateRepository - createsonly therepository inan
Edition existing RDBM S installation and database.
e Create Database - creates both the database and
repository in an existing RDBM S installation.
¢ Ingtall DB2 7.2 Personal Edition - “batteries
included” installation optioninstallsthe RDBM Sand
creates a database and repository tables.
IBM DB2 7.2 Create Repository - creates only the repository in an
Enterprise Sever Edition | existing database and RDBMS installation.
IBM DB2 8.1 Create Repository - creates only the repository in an
Enterprise Personal existing database and RDBM S installation.
Edition
Oracle 8.1.7 or 9i « CreateRepository - createsonly therepository inan
existing database and RDBM S installation.
¢ Create Tablespace - creates both the tablespace and
repository in an existing RDBMS installation.
Note: Root user permissions are required to create a
tablespace in Oracle.
SQL Server 2000 «  Not supported for UNIX.

Based on Table 6, you can make a decision from the following examples:

« For afirst timeinstalation, select the “ batteries included” option, or
Create Database/Tablespace and Create Repository.

« If you have aready created the database, select Create Repository.

« Ifyouareupgrading, uncheck all options. Theinstaller will upgrade your
repository automatically.
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12. Click Next.
The Configure RDBM S Repository window, for your RDBMS selectionis
displayed.

13. Enter the following RDBM S specific connection information into the
Configure RDBM S Repository window according to Table 7 through Table 9
on page 43.

Table 7: IBM DB2 Personal Edition Connection Information

Text Box Entry
Destination Folder The path to store IBM DB2 Personal Edition software.
DB2 Database Name The database application name. The default is
ANALY Z65.
DB2 Administrator The DB2 administrator’s username.
Name
DB2 Administrator The password for the DB2 administrator’s username.
Passwor d

Table 8: DB2 7.2 and 8.1 Connection Information

Text Box Entry

DB2 Server The explicit database server name. Using
“I ocal host” isnot recommended

DB2 Database Name The database application name. The default is
ANALY Z65.

DB2 Administrator The DB2 Administrator’s username.

Name

DB2 Administrator The password for the DB2 administrator’s username.

Passwor d

Port The port number used for client-server communication;
the default is 50000

JDBC Driver Path The path to the IDBC driver; the default filename is
db2j ava. zi p.
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Table 9: Oracle Connection Information

Text Box Entry

Oracle Server The explicit database server name. Using
“I ocal host " isnot recommended.

OracleSID The Oracle SID.

Oracle Tablespace Name | The name of the Oracle tablespace.

Oracle Username The Root account username,

Oracle Password The password for the Root account username.
Port The port used for client-server communication.
JDBC Driver Path The path of the Oracle JDBC driver; the default

filenameiscl asses12. zi p.

14. Optional: To ensure the connection information is entered correctly, click
Test Connection when installing Hyperion Analyzer to an existing RDBM S

repository type.

At this point in the installation process you can specify the JDBC drivers for
an RDBM Stypeto establish adrill-through connection with another, existing
database. This second set of RDBM S type and JDBC driver selections that
supports relational drill-through functionality is optional.

15. Take one of the following actions:

« If adrill-through connection is not required, proceed to step 17.

« If adrill-through connectionisrequired, select an available RDBM Stype:
— DB2 7.2 Fixpack 7 Enterprise
— DB28.1 Enterprise
— Oracle8.17
— Oracle9.2.7
— MSSQL Server 2000 SP3
— Teradata4.l
A corresponding JDBC driver path field is displayed.
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16. Enter or browse to the path name of the JIDBC driver. For example, the JDBC

driver file name for Oracleiscl asses12. zi p.
17. Click Next.

The Configure Hyperion Analyzer window is displayed, as shown in

Figure 13 on page 44.

Completing the XWindows (UNIX) installation of Hyperion Analyzer
involves configuring the installation and reviewing the installation summary.

Figure 13: Hyperion Analyzer Installation Configure Hyperion Analyzer Window
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18. Enter the appropiate information into the following fields:

« Inthe Destination Folder text box, enter the path where you want
Hyperion Analyzer software to be installed. The defaullt is:
<dri ve>/ hyperion/ anal yzer

« Inthe Servlet Engine Name text box, type the name of the Servlet

Engine. The default is Analyzer6_Server.
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« Inthe RDBM S Repository Username text box, enter the username of a
valid RDBMS user with Administrator privileges.

« Inthe RDBM S Repository Password text box, enter the valid password
for the username.

19. Click Next.

The Installation Summary window is displayed. The summary provides alist
of configuration selections you have made.

20. Review the summary and take one of the following actions:
« Tomake correctionsin the installation configuration, click Back.

« If theconfiguration is correct, click Next.
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Hyperion Analyzer isinstalled. When the installation is complete, the Setup
Complete window is displayed. A checkbox is displayed to view the
installation logfile only if there are installation errors.

Figure 14: Hyperion Analyzer Installation Setup Complete Window

Hyperion Analyzer 6.5.0.0.00698 ==
o0
o o Hyperion

Setup has completed. To check the install log, check the box below.

The initial Hyperion Analyzer administration account is:

Language

Welcome Login: Administrator
Usage Made Password: password
License Agreement

SERCtANpIESInS e Please read the release notes for further information.

Configure Application Server

Select RDBMS Repository You can begin anahzing at:
Configure RDBMS Repositony <
hitp:lf <servers fAnalyzert_Serverfindex.himl
Specify Relational Connectivity
Configure Hyperion Analyzer
Summary Setup has completed without any errors.

Perform Install
Setup Complete

Cancel Hext

Note: The default user and password are Administrator and password respectively.
The default domain is Analyzer. The installation log file is located in the

<Desti nati on Fol der >/ hyaset up. <ti nest anp>. | og, where

<Dest i nati on Fol der > is the directory where Hyperion Analyzer software is
installed and <t i mest anp> is the date and time of installation.

21. Click Next.

The Setup Completewindow closes and theinstallation of Hyperion Analyzer
for UNIX is complete.
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22. Log off and log back on to the server.

CAUTION: You must log off of the server and log on again after sourcing
the anal yzer . sh into the profile for Hyperion Analyzer to operate properly.

After Installing Hyperion Analyzer

Before launching Hyperion Analyzer, you must perform are described in the
following topics applicable to your installation choices:

« “Manual Deployment of WebSphere and WebL ogic” on page 47
« “Configuring External and Application Security” on page 47

« “Setting Environmental Variables’ on page 48

. “Starting the Hyperion Essbase OLAP Server” on page 50

. “Starting RDBMS Services’ on page 50

. “Starting the Hyperion Analyzer Server” on page 51

Manual Deployment of WebSphere and WebLogic

If an existing installation of IBM WebSphere or BEA WebL ogic are selected asthe
application server to deploy Hyperion Analyzer into, some manual deployment
configurations must be executed before continuing. The following chapters
provide the procedures and information required to deploy manualy to the
application servers:

« Chapter 4, “Deploying Hyperion Analyzer into IBM WebSphere”
« Chapter 5, “Deploying Hyperion Analyzer to BEA WebLogic”

Configuring External and Application Security

Once Hyperion Analyzer has been installed, at any time you have the option of
implementing one of several security methods. Security can be broken down into
external authentication and internal authorization. Hyperion Analyzer providesthe
following options for implementing security:

« Analyzer Security (default)
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« [Essbase Security
« External Authentication

The default Hyperion Analyzer security configuration is application security.
Without avalid username and password, which is contained in the Hyperion
Analyzer repository, you are not authenticated as a user in Hyperion Analyzer.

Although not required for Hyperion Analyzer to operate, it is advisable to
implement an external authentication method for integrating with other Hyperion
products. Thisis provided by utilizing existing Hyperion Essbase security or
configuring an existing authentication method such as the following:

« Lightweight Directory Access Protocol (LDAP)
« Microsoft Windows NT LAN Manager (NTLM)
« Microsoft Active Directory (MSAD)

For more information on these security options see Chapter 4 “Managing Security
Access’ of the Hyperion Analyzer Administrator’s Guide.

Setting Environmental Variables

[ To set the environment variables:

1. Ensurethat Hyperion Essbase has been installed and configured, and that two
(2) environmental variables are set correctly.

« ARBORPATH

«  Set the variable to one of the following:
— LD_LI BRARY_PATHfor Sun Solaris
— LI BPATHfor IBM AIX
— SH LI B_PATHfor HP_UX

If Hyperion Esshaseisinstalled, the Library path should be correctly defined. See
the examples below for detailed descriptions.

The Hyperion Analyzer installation generates an anal yzer . sh script and stores
it in the user home directory. This script enables client-server communication
between Hyperion Analyzer and Hyperion Essbase, and indi cates the language to
be used by the Hyperion Analyzer interface.
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2. Edit the global shell environment to reference the Hyperion Analyzer shell
script located in the user home directory. For example:
/. anal yzer. sh

3. Log off and then log on again to ensure that the environment detects the
changes.

The following sections provide environmental variable examples for each of the
supported UNIX operating systems.

IBM AIX 4.3.3 Example

.profile entries:
export ARBORPATH=/ usr/ hyperi on/ essbase
export PATH=$ARBORPATH bi n: $PATH

#L1 BPATH for Al X LD LI BRARY_PATH for SOLARI S
export LIBPATH=
$ARBORPATH dynami c: $ARBORPATH api / | i b: $ARBORPATH bi n

/. anal yzer. sh

.analyzer.sh entries:

LI BPATH=/ usr/ hyperi on/ anal yzer/ adni bi n/ ai x: $L1 BPATH
#

#

export LI BPATH

Sun Solaris 8 Example

.profile entries:

ARBCORPATH=/ opt / hyperi on/ essbase

export ARBORPATH

LD LI BRARY_PATH=$LD LI BRARY_PATH: / opt/ hyperi on/ essbase/ bi n
export LD LI BRARY_PATH

/. anal yzer. sh
.analyzer.sh entries:

LD _LI BRARY_PATH=
/ opt/ hyperion/ anal yzer/adni bi n/ sol ari s: $LD_LI BRARY_PATH
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#
#
export LD LI BRARY_PATH

HP-UX 11i Example

.profile entries:
export ARBORPATH=/ usr/ hyperi on/ essbase65r
export SHLI B_PATH=$ARBORPATH bi n

.analyzer.sh entries:

SHLI B_PATH=/ usr/ hyperi on/ anal yzer/ adni bi n/ hpux: $SHLI B_PATH
#

#

export SH LI B_PATH

Starting the Hyperion Essbase OLAP Server

[] To start the Esshase OLAP server:

1. From the Windows desktop, click Start > Programs > Hyperion Solutions
> Hyperion Essbase > Essbase OL AP Server.

2. Enter avalid password and press Enter.

Starting RDBMS Services

Starting IBM DB2 Enterprise Personal Edition

If you selected and installed IBM DB2 Enterprise Personal Edition as your
repository, ensure that the following services are started:

. DB2-DB2
. DB2-DB2DAS00
. DB2JDBC Applet Server
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Starting the Hyperion Analyzer Server

Follow the instructionsin your application server documentation to start
application servers other than Apache Tomcat. If you selected Apache Tomcat as
your application server, the next section provides starting and stopping procedures.

Starting and Stopping the Tomcat Application Server

If you selected the Apache Tomcat application server during the installation
process, you must start the server before launching Hyperion Analyzer and stop
the server when your work is compl ete.

[l To start the Apache Tomcat application server click Start > Programs >
Hyperion Solutions> Hyperion Analyzer 6.5 > Start Analyzer Server.

[l To stop the Apache Tomcat application server click Start > Programs >
Hyperion Solutions> Hyperion Analyzer 6.5 > Stop Analyzer Server.

Starting Hyperion Analyzer
Deploy the following Hyperion Analyzer launch page URL to your users:
htt p:// <host nanme>/ Anal yzer 6_Ser ver/i ndex. ht m

[l To start the Hyperion Analyzer Client:
1. Open abrowser, enter the launch page URL, and press Enter.
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The Hyperion Analyzer Launch Page is displayed.

Figure 15: Hyperion Analyzer Launch Page

oo
o o Hyperion

HYPERIOH® ANALYZER

Jawa Wweb Client
HTML Web Client
Adrninistration Tools Client

Analysis Server Consale

welcome to the Hyperion® Analyzer Launch Page

Java Web Client

Using Java technaology, the Hyperion Analyzer Java web Client
offers Web-based functionality at its best, This client enables users
to create and save sophisticated analytical reports using a single
interface. The Java web Client is ideal for advanced business
analysis users and report designers, Launch

HTML Web Client

The Hyperion Analyzer HTML web Client is a zero-footprint
Hyperion Analyzer client based on standard HTML technology.
Because of its streamlined, intuitive user-interface, this Wweb client
is ideal for users focused on using - rather than creating -
business analyses, Launch

Administration Tools Client

Hyperion Analyzer Administration Tools is a graphical user-
interface for managing users, user groups, database connections
and security roles, Launch

Analysis Server Console

The Hyperion Analyzer Analysis Server Console enables
administrators to remotely monitor and control Hyperion Analyzer
Analysis Servers, Launch

2. Select from the following list of options:
« JavaWeb Client
« HTML Web Client
« Administration Tools Client

« Analysis Server Console
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The selected option opensin anew browser window. The appropriate client
starts and the Login page is displayed.

Note: If you do not have the correct Java console, you are prompted to permit it to
be automatically installed.

Enter avalid User 1D and Password, then click Login.

The Hyperion Analyzer option is displayed in the browser.

The Hyperion Analyzer Launch Page

The Hyperion Analyzer Launch Pageis a great source of information and other
Hyperion Analyzer resources. From the Launch Page you can:

Link to Essbase.com

Launch the Information Map

See instructions on how to install a sample report group
Access to the Hyperion Analyzer API Toolkit Jump Start Guide
Launch asample HTML Web Client
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What's Installed?

This chapter providesinformation about what isinstalled with Hyperion Analyzer
and whereit islocated. Installation |ocations are based on the deployed application
server. In general however, Hyperion Analyzer is structured as described in the
tables in the following sections.

Hyperion Analyzer Top-Level Directories

Where ever Hyperion Analyzer isinstalled on your system, the following table
lists the directories under the top level of the\ anal yzer directory.

Table 10: Hyperion Analyzer Top-Level Directories

Directory Description

adm The directory containing Hyperion Analytical Data
Model highest directory level (a Java API to Hyperion
Esshase)

appserver The directory containing the application server installed
with Hyperion Analyzer

conmon The directory containing the DLL used for
implementing external authentication

conf The directory containing configuration files

css The directory containing JRE jar files for implementing
external authentication

j dk The directory containing the Java SDK files

utils The directory containing the migration utilities for

previous versions of Hyperion Analyzer
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Table 10: Hyperion Analyzer Top-Level Directories(Continued)

Directory Description

wp_out put The directory used for Web publishing functions within
Hyperion Analyzer for application servers other than
Apache Tomcat

wp_t enpl at es The directory used for Web publishing templates within
Hyperion Analyzer for application servers other than
Apache Tomcat

Hyperion Analyzer Server Directories

If you have installed Apache Tomcat with Hyperion Analyzer the server
directories are in the following directory path:
\ hyperion\anal yzer\ appser ver\ webapps\ Anal yzer 6_Ser ver\

If you haveinstalled Hyperion Analyzer in an existing Apache Tomcat installation
the server directories are in the following directory path:
<tontatinstal |l root >\ appserver\ webapps\ Anal yzer 6_Server\

If you installed Hyperion Analyzer into an existing Application server the
directories are in the following directory path:
\ hyperi on\ anal yzer\

All of the Hyperion Analyzer files are contained in the Anal yzer . ear file. See
Chapter 4, “Deploying Hyperion Analyzer into IBM WebSphere,” or Chapter 5,
“Deploying Hyperion Analyzer to BEA WebLogic,” for more information about
deploying the EAR file.

The directory contains an\ Ear subdirectory. This contains the contents of the
EAR file. When changes are made to the deployment, they can be made to this
directory. Then when it istime to redeploy the EAR file, you can rebuild it using
the /analyzer/utils/rebuild_ear.shfile.

Table 11: Hyperion Analyzer Server Directories

Directory Description

anayzer This directory isfor later use by Hyperion Analyzer.

Help This directory containing the documentation for
Hyperion Analyzer
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Table 11: Hyperion Analyzer Server Directories(Continued)

Directory

Description

i mges

This directory containing the graphics used by the
launch page.

i mages_| aunch

This directory contains

| ogs Thisdirectory isfor later use by Hyperion Analyzer.

sanpl es This directory contains the .arg files for installing the
Hyperion Analyzer sample report groups.

tenp Thisdirectory isfor later use by Hyperion Analyzer.

t enpl at es This directory contains report templates used by the

Java Web Client.

tenpl at es_de

This directory contains report templates used by the
Java Web Client in German.

tenplates_fr

This directory contains report templates used by the
Java Web Client. in French.

tenpl ates_ja

This directory contains report templates used by the
Java Web Client. in Japanese.

tenpl at es_j aval ook

This directory contains report templates used by the
Java Web Client in an aternate look and feel.

tenpl ates_t oggl e

This directory contains alternate report templates used
by the Java Web Client.

WEB- | NF This directory contains other application server
configuration and library files.

wp_out put Thisdirectory is used for Web publishing functions
within Hyperion Analyzer. This directory islocated
here only for Apache Tomcat.

wp_t enpl at es Thisdirectory is used for Web publishing functions

within Hyperion Analyzer. This directory islocated
here only for Apache Tomcat.
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Deploying Hyperion Analyzer
Into IBM WebSphere

If you are using IBM WebSphere, you must manually deploy Hyperion Analyzer
into a previously installed IBM WebSphere application server. It is assumed that

all system requirements have been met and that the Hyperion Anayzer installation
has been executed, including the selection of IBM WebSphere as the application

serve.

Deploying to IBM WebSphere

Deploying to IBM WebSphere Advanced Edition

The following procedures are described for IBM WebSphere Advanced Edition.
Those using IBM WebSphere Advanced Edition Single Server, should proceed to
“Deploying to Advanced Edition Single Server” on page 62.

Installing the Web Application

To install the Hyperion Analyzer Web application:

1. Copy the output Anal yzer 65. ear enterprise archive file from the location
designated as the destination folder.

You have the option of placing acopy of the Anal yzer 65. ear inthe
WebSphere| nst al | abl e Apps directory.

CAUTION: Do not place the archive file in the | nst al | edApps directory
or Hyperion Analyzer is unable to start.
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4.

Open the WebSphere Administration Server Console.

Right-click the Enter prise Applications node in the navigation window (on
the left side of the console interface).

Select Install Enterprise Application.

Note: Leave the Application Name field blank on this window.

5.

6.

Click Browse, navigate to the Anal yzer 65. ear enterprise archivefile
located in the default Installable Apps directory, and open it.

Click Next.

Setting Up WebSphere Security

During the deployment process, you are prompted to set up WebSphere system
security by the Mapping Users to Roles dialog box.

To set up WebSphere security and define user permissions:

1.

With the Everyone label selected, click the Mapping Usersto Roles select
button.

Inthe Select User Groups— Everyonedialog box, select the Everyone (No
authentication) check box, then click OK.

WebSphere indicates that all Hyperion Analyzer users belong to asingle
security group, called Everyone. You can specify Hyperion Analyzer roles
and permissions later, using Hyperion Analyzer Administration Tools.

Proceed through the next series of installation pages until you reach the
Selecting Application Servers page.

This window enables IBM WebSphere Enterprise Server Edition to specify
the application serversin the network cluster supporting Hyperion Analyzer.

The Confirm the Following isthe last page in the series.

Ensure that the node, port, and the fully qualified pathname to the
I nst al | edApps directory aredisplayed inthe Confirm the Following page.

These descriptions must be correct and match the information you provided to
the Hyperion Analyzer installation exactly. If they do not, you have the option
of reinstalling or modifying theweb. xm configuration file manually.

Click Finish to complete installation of the enterprise application.
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Regenerating the Web Server Plug-in

[l To regenerate the Web Server Plug-in:

1.
2.

o 0~ w

Open the WebSphere 4 Administration Server Console.

Expand the Nodes node in the navigation window (at the left side of the
console interface).

Right-click the server node where Hyperion Analyzer isinstalled.
Select Regen Webserver Plug-in.
Go to Microsoft Windows Services and stop and start the IBM HTTP Server.

Reboot the WebSphere server for the new environmental variables to take
effect.

Start the Hyperion Analyzer Web Application

[l To start the Hyperion Analyzer Web application:

1.
2.

Open the WebSphere Administration Server Console.

Expand the Enterprise Application node in the navigation window (on the
left side of the console interface).

Right-click the Hyperion Analyzer application.
Select Start.

Open a Web browser and enter the URL provided in the last window of the
Hyperion Analyzer installation. The default URL is
http:// Anal yzer6_Server/index. htm .

The Hyperion Analyzer launch page is displayed, and you can begin
multidimensional and relational analysiswith the Hyperion Analyzer client of
your choice.
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Deploying to Advanced Edition Single Server

Installing the Web Application

[l Toinstall the Hyperion Analyzer enterprise application:

1. Copy the output Anal yzer 65. ear enterprise archive file from the location
designated as the destination directory. The default is
C.\ Hyperion\ Anal yzer.

You have the option of placing a copy of the archive in the WebSphere
I nstal | abl e Apps directory.

CAUTION: Do not place the archive file in the | nst al | edApps directory
or Hyperion Analyzer is unable to start.

2. Open the WebSphere Administration Server Console.

3. Expandthe Nodes node and the server node where Hyperion Analyzer isto be
installed, then select Enterprise Application.

4. Click thelnstall button.
Note: Leave the Application Name field blank on this window.

5. Usethe Browse button to navigate to the enterprise archive fileg; the default is
thel nst al | abl e Apps directory.

6. Click Next.

Set Up WebSphere Security

During the deployment process you are prompted to set up WebSphere system
security. The WebSphere Application Installation Mapping Roles to Users page
indicatesthat all Hyperion Analyzer users belong to asingle security group, called
Everyone.

[1 To set up WebSphere security and define user permissions:

1. Inthe Mapping Rolesto Users page, select the Special Subjects Everyone
check box.
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You can specify Hyperion Analyzer roles and permissions | ater, using
Hyperion Analyzer Administration Tools.

The Confirm the Following isthe last page in the series.

2. Ensurethat the node, port, and the fully-qualified pathname to the
InstalledApps directory are displayed in the Confirm the Following page.

These descriptions must be correct and match the information that you
provided to the Hyperion Analyzer installation exactly. If they do not, you
have the option of reinstalling or modifying theweb. xm configuration file
manually.

3. Click Finish to complete installation of the enterprise application.

Regenerating the Web Server Plug-in

[l To regenerate the Web Server Plug-in:
1. Open the WebSphere 4 Administration Server Console.

2. Expand the Nodes node and the server node where Hyperion Analyzer is
installed. Expand the Application Serversnode, then click Default Server.

3. Under the Advanced Settings banner, click Web Server Plug-in
Configuration.

4. Click the Generate button.
Go to Microsoft Windows Services and stop and start the IBM HTTP Server.

6. Reboot the WebSphere server for the new environmental variables to take
effect.

Starting the Hyperion Analyzer Web Application

[l To start the Hyperion Analyzer Web application:
1. Open the WebSphere Administration Server Console.

2. Locate and expand the Nodes node and the node where Hyperion Analyzer is
installed.

3. Ontheleft side of the console interface, click the Enterprise Application
node in the navigation page.

4. Select the new Web application item checkbox (Analyzer65).
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5. Click the Start button.

6. Forinstructions on continuing with theinstallation by returning to the section;
Configuring External and Application Security of theinstallation in Chapter 2.
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Deploying Hyperion Analyzer
to BEA WebLogic

Deploying to BEA WebLogic

You must manually deploy Hyperion Analyzer into apreviously installed BEA
WebL ogic 6.1 or 7.0 application server.

[0 To manually deploy Hyperion Analyzer to a BEA WebL ogic 7.0 application
server:

1.
2.
3.

Start the BEA WebL ogic Server.
Start the WebL ogic Server Console.

Navigate to Deployments>Applications, then click Configure a new
Application.

Steps for deployment are displayed on this Web page. Under Step 2 a series
of hyperlinks follows the “Listing of” text.

Click the correct drive and navigate to the newly created enterprise archive
(EAR) file.

When the correct EAR fileis displayed, click its corresponding [select]
hyperlink.

Step 3 of the deployment process prompts you to indicate the server to which
the EAR fileis deployed.

Select an Available Server, and moveit to the Target Server window using
the arrow button control.

Enter aname for the Application in the Step 4 field, the default is
“Analyzer65”.

Click the Configure and Display control button.
The WebL ogic Server EAR fileis configured and deployed.
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9. Continue with the installation by returning to the section; “Configuring
External and Application Security” on page 47 of theinstallationin Chapter 2.
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Creating Repositories with
Scripts

Database administrators might want to create repositories by running scriptsrather
than distributing their security information. All SQL scripts can be stored in one
of the following locations:

« TheSQ.Scripts. zi p archivein the CD-ROM Repository subdirectory
« TEMP/ _hya_t np directory(after installation)

Scripts can berun for each of the RDBM Stypes that Hyperion Analyzer supports.
The following sections contain the procedures for creating repositories:

“Creating the Repository for IBM DB2" on page 67
“Creating the Repository for Oracle” on page 69
“Creating the Repository for SQL Server” on page 72

Creating the Repository for IBM DB2

There are three scripts for creating an IBM DB2 repository:

« Anal yzer Creat eDat abaseDB2. sql createsan IBM DB2 7.2 Enterprise
Server Edition database.

« Anal yzer Creat eTabl esDB2. sql createsall repository tables for both
editions of DB2.

« Anal yzer Def aul t Dat aDB2. sql populates tables with Hyperion Analyzer
default configuration data (IBM DB2 7.2 Enterprise Server Edition).
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[l To create an IBM DB2 repository:

1. OpentheAnal yzer Cr eat eDat abaseDB2. sql script in an SQL editor and
modify the following parameters:

Table 12: Anal yzer Cr eat eDat abaseDB2. sql Script Parameters for IBM DB2

Parameter Description

*x%* CAPSDBNAME®*** The Hyperion Analyzer database name.
Replace with ANALYZ65.

*xx* DBNAME**** The Hyperion Analyzer database name.
Replace with ANALYZ65.

**x* DB2USERNAME* *** Replace with the user ID of the DB2
Administrator.

***x* DB2PASSWORD* *** Replace with the corresponding DB2

Administrator's password.

*xxkk CAPSUSER* *** Replace with an RDBM S repository username
with which an administrator can access the
database application.

Note: The username can have a maximum of
eight (8) characters.

Note: Administrators do not need to modify the SQL if they use the SQL scripts
generated by the installation. See TEMP/ _hya_t np.

2. Saveyour modifications and run the SQL script.

3. OpentheAnal yzer Cr eat eTabl esDB2. sql script in an SQL editor and
modify the following parameters:

Table 13: Anal yzer Cr eat eTabl esDB2. sql Script Parameters for IBM DB2

Parameter Description

**xx CAPSDBNAME**** The Hyperion Analyzer database name. Replace
with ANALY Z65.

**xx DBNAME**** The Hyperion Analyzer database name. Replace
with ANALY Z65.

****DB2USERNAME**** The user ID of the DB2 administrator.
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Table 13: Anal yzer Cr eat eTabl esDB2. sql Script Parameters for IBM

Parameter Description

**** DB2PASSWORD* *** Replace with the corresponding DB2
Administrator's password.

*x %% CAPSUSER* *** Replace with an RDBM S repository username
with which an administrator can access the
database application.

Note: The username can have a maximum of
eight (8) characters.

4. Save your modifications and run the SQL script.

5. OpentheAnal yzer Cr eat eDat abaseDB2. sql scriptinan SQL editor and
modify the following parameters:

Table 14: Anal yzer Cr eat eDat abaseDB2. sql script Parameters for IBM DB2

Parameter Description

*xx* CAPSDBNAME**** The Hyperion Analyzer database name. Replace
with ANALY Z65.

*xxkk CAPSUSER* *** Replace with an RDBM S repository username
with which an administrator can access the
database application.

Note: Administrators do not need to modify the SQL if they use the SQL scripts
generated by the installation. See TEMP/ _hya_t np.

6. Saveyour modifications and run the SQL script.

Creating the Repository for Oracle
There are four scripts for creating a Oracle repository:
« Anal yzer Cr eat eDat abaseOr acl e8i . sql creates the Oracle database.

« Anal yzer CreateTabl esO acl e8i . sql createsthe Hyperion Analyzer
repository tables.
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« Anal yzer Def aul t Dat aOr acl e8i . sql populatesthetableswith Hyperion
Anayzer default configuration data.

« Anal yzer Creat eRenoveOr acl e8i . sql isascript used internally by the
create database script.
[l To create an Oracle repository:

1. OpentheAnal yzer Cr eat eDat abaseOr acl e8i . sql scriptinaSQL editor
and modify the following script parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts
generated by the installation. See TEMP/ _hya_t np.

Table 15: Anal yzer Cr eat eDat abaseOr acl e8i . sgl script Parameters for

Oracle

Parameter Description

****DB2USERNAME**** Replace with the user ID of the Oracle
Administrator.

*x%* DB2PASSWORD* * ** Replace with the corresponding Administrator's
password.

*xxkk CAPSUSER* *** Replace with an RDBM S repository username
with which an administrator can access the
database application.

Note: The username can have a maximum of
eight (8) characters.

*x %% PASSWORD* ** * Replace with the corresponding CAPSUSER
password.

2. RuntheAnal yzer Cr eat eDat abaseOr acl e8i . sql script.
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3. OpentheAnal yzer Cr eat eTabl esOr acl e8i . sgl scriptinaSQL editor
and modify the following script parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts
generated by the installation. See TEMP/ _hya_t np.

Table 16: Anal yzer Cr eat eTabl esOr acl e8i . sql  Script Parameters for

Oracle
Parameter Description
*x %% JSERNAME**** Replace with an RDBM S repository username with

which an administrator can access the database
application.

Note: The username can have a maximum of eight
(8) characters.

4. RuntheAnal yzer Cr eat eTabl esOr acl e8i . sgl script.

5. OpentheAnal yzer Def aul t Dat aOr acl e8i . sql scriptinaSQL editor and
modify the following script parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts
generated by the installation. See TEMP/ _hya_t np.

Table 17: Anal yzer Def aul t Dat aOr acl e8i . sgl Script Parameters for Oracle

Parameter Description

****DB2USERNAME**** Replace with the user ID of the Oracle
Administrator.

****x DB2PASSWORD* * ** Replace with the corresponding Administrator's
password.

*x*x* USERNAME**** Replace with an RDBM S repository username

with which an administrator can access the
database application.

Note: The username can have a maximum of
eight (8) characters.

6. Runthe Anal yzer Def aul t Dat aOr acl e8i . sgl script.
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Creating the Repository for SQL Server

There are four scripts for creating a SQL Server repository:

72 m

Anal yzer Cr eat eDat abaseMsSQL. sql createsthe SQL Server database.

Anal yzer Cr eat eTabl esMSSQL. sqgl creates the Hyperion Analyzer
repository tables.

Anal yzer Def aul t Dat aMSSQL. sql populates the tables with Hyperion
Analyzer default configuration data.

Anal yzer RenoveDat abasesMSSQL. sql isascript used internally by the
create database script.

To create an SQL Server repository:

1.

Open the Anal yzer Cr eat eDat abase. sql scriptinaSQL editor and
modify the following script parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts
generated by the installation. See TEMP/ _hya_t np.

Table 18: Anal yzer Cr eat eDat abase. sql Script Parameters for SQL Server

Parameter Description
**x* DBNAME**** The Hyperion Analyzer database name. Replace with
ANALY Z65.

*xxx JSERNAME**** Replace with an RDBMS repository username with

which an administrator can access the database
application.

Note: The username can have a maximum of eight
(8) characters.

**% % DA SSWORD* * * * Replace with the corresponding USERNAME

password.

2. RuntheAnal yzer Cr eat eDat abaseMsSSQL. sql script.
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3. OpentheAnal yzer Cr eat eTabl esM5SQL. sql script ina SQL editor and
modify the following script parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts
generated by the installation. See TEMP/_hya_tmp.

Table 19: Anal yzer Cr eat eTabl esMSSQL. sql Script Parameters for SQL

Server
Parameter Replace With
*x %% JSERNAME**** Replace with an RDBM S repository username with

which an administrator can access the database
application.

Note: The username can have a maximum of eight (8)
characters.

4. Select the correct database from the query analyzer tool drop-down list box.

5. RuntheAnal yzer Creat eTabl esMSSQL. sql script.

6. RuntheAnal yzer Def aul t Dat aM8SQL. sql script.
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Importing Hyperion Analyzer
Sample Reports

Hyperion Analyzer provides sampl e reports contained in two report groupsfor you
to import into your Hyperion Analyzer repository based on the Hyperion Essbase
sample application:cube called Sample:Basic. The following topics describe how
to import the Sample Reports and the APl Samples report groups.

“Creating a Database Connection” on page 75
“Importing the Sample Report Group” on page 76
« “Importing the APl Samples Report Group” on page 77
The procedures assume the following conditions:
o Hyperion Analyzer isinstalled.
o A valid Esshase OLAP server has been started.
« A vadlid application server has been started.

Importing Sample Reports

Creating a Database Connection
It is necessary to create a database connection to the Hyperion Essbase cube
before importing the sample reports.
[J To import the sample report group and reports:
1. Start Hyperion Analyzer Java Web client.
2. Start asupported Web browser.
3. Select File> Open.
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4. Enter the URL of the Hyperion Analyzer launch page (as copied from the last
installation window), and press Enter.

For example:
http://<servername>/ Anal yzer6_Server/webapp/ Anal yzer 6/ i ndex. ht m

5. Onthe Hyperion Analyzer Launch Page, click the Java Web Client link.
The Login page is displayed.

6. Enter avalid user ID and password (Administrator/password) and click OK.

7. InHyperion Analyzer, select Tools > User Preferencesfrom the drop-down
menu.

The User Preferences dialog box is displayed.

8. Click the Connections screen name in the navigation window.
The Connections User Preferences tab is displayed.

9. Click the Add New button.
The Select Database Type dialog box is displayed.

10. Select Hyperion Essbase from the drop-down list and click OK.
The Hyperion Essbase Login dialog box is displayed.

11. Specify the Hyperion Essbase server, and a valid Hyperion Essbase user ID
and password, then click OK.

The List Databases dialog box is displayed.

12. Select Sample:Basic from the Available Databases list and click the
right-arrow (>) button.

Sample:Basic is added to the Selected Databases list.
13. Click OK.

Sample:Basic is added to the Connections User Preferences list.
14. Click Apply, then click Close.

Importing the Sample Report Group
It is necessary to import a report group by using the Java Web Client.

Note: You must be and Administrator or Power User and have write privileges to import
a report group.
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[l Toimport asample report group:

1.

From the Java Web Client Menu Bar select File | Import | Report Group.
The Open dialog box is displayed.

Select the Sanpl e Report s. ARGfilelocated in the following directory:
Hyperi on\ anal yzer\ appser ver\ webapps\ Anal yzer 6_Server\ sanpl es
The Map Connections dialog box is displayed.

Select localhost: Sample:Basic from the Exported Connection list, then
select the database connection that you just created in the Available Database
Connections list.

Click the Map It! button.

Click OK.

Type Sample Reports for the report group name and click OK.
The report group is saved to the repository.

Importing the API Samples Report Group

[1 Toimport the API Samples report group:

1.

From the Java Web Client Menu Bar select File | Import | Report Group.
The Open dialog box is displayed.
Select theapi _sanpl es. ARGfile located in the following directory:

Hyperi on\ appserver\ host s\ def aul t _host\ Anal yzer 6_Ser ver\
Anal yzer 6\ web\ sanpl es

The Map Connections dialog box is displayed.

Select localhost: Sample: Basic from the Exported Connection list, and then
select the database connection you just created from the Available Database
Connectionslist.

Click the Map It! button.

Click OK.

Type API Samplesfor the report group name and click OK.
The API Samples report group is saved to the repository.
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Uninstalling Hyperion
Analyzer

Uninstalling Hyperion Analyzer from UNIX

(1 Touninstall Hyperion Analyzer from your UNIX system:
1. Loginintothe server.
2. Delete the directory that you installed Hyperion Analyzer.
3. Perform one of the following:

. If you modified the analyzer.sh file to set the environment variables, edit
out the environment variable changes you made.

« Remove the set resource environment variables.

Hyperion Analyzer has been removed from your system.
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Additional Support
Consulting Services, xiii
Education Services, xii
printed documentation, xii
Technical Support, xiii
Advanced Edition
deploying to WebSphere, 59
WebSphere security setup, 60
Advanced Edition Personal Server
deploying to WebSphere, 62
WebSphere security setup, 62
after installation
setting environmental variables, 48
starting Hyperion Analyzer, 51
Starting Hyperion Essbase OLAP Server, 50
starting RDBM S services, 50
starting the Hyperion Analyzer server, 51
Apache Tomcat Application Server,
starting and stopping, 51
APl Samples report group
importing, 77
application components
Administration Tools, 15
Analysis Server, 15
API Toolkit, 15
HTML Web Client, 15
JavaWeb Client, 15
Repository, 15
Windows Client, 15
application security, 47
application server options
Apache Tomcat 4.0, 37
BEA WebLogic 6.1, 38
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BEA WebLogic 7.0, 38
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authentication, 47
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B

backing up existing repositories, 31
BEA WebL ogic, deploying to, 65
before installation checklist, 29
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client System Requirements, 28
connection information
DB27.2and 8.1, 42
Oracle, 43
creating
Database connections, 75
Hyperion Analyzer repositories, 67
creating a repository
for IBM DB2, 67
for Oracle, 69
for SQL Server, 72
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Database Connection

creating, 75
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connection information, 42
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to IBM WebSphere, 59
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architectural diagram, 16
BEA WebL ogic, 65
before installation, 29
creating repositories, 67
IBM WebSphere, 59
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installation options, 23
installation procedure, 32
Pre-Installation checklist, 29
repository backup, 31
repository migration, 31
security, 47
starting, 51
system requirements, 25
uninstalling from UNIX, 79

Hyperion Analyzer server,
starting, 51

Hyperion Essbase OLAP Server
starting, 50

IBM DB2
additional information about, 30
creating arepository for, 67
Enterprise Server Edition, 31
Personal Edition, 31
IBM DB2 script
AnayzerCreateDatabaseDB2.sql, 67
AnalyzerCreateTablesDB2.sql, 67
AnalyzerDefaultDataDB2.sql, 67
IBM WebSphere, deploying to, 59
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Sample Report Group, 76
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locating SQL scripts, 67
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options for deployment, 18

Oracle
connection information, 43
creating arepository for, 69

Oracle script
AnalyzerCreateDatabaseOracle8i.sqgl, 69
AnalyzerCreateRemoveOracle8i.sgl, 70
AnalyzerCreateTablesOracle8i.sql, 69
AnalyzerDefaultDataOracle8i.sql, 70
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Pre-Installation checklist, 29
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RDBMS repository options
IBM DB2 7.2 Enterprise Sever Edition, 41
IBM DB2 7.2 Personal Edition, 41
IBM DB2 8.1 Enterprise Personal Edition, 41
Oracle8.1.7, 41
Oracle 9i, 41
SQL Server 2000, 41
RDBMS services, starting, 50
repository
backup, 31
migration, 31
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sample database
Sample Basic, 75

Sample Report Group
importing, 76
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security
application, 47
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setting environmental variables
HP-UX 11i example, 50
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Sun Solaris 8 example, 49
UNIX, 48
SQL script
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AnayzerCreateTablesM SSQL .sql, 72
AnalyzerDefaultDataM SSQL .sql, 72
AnalyzerRemoveDatabasesM SSQL .sql, 72
locating, 67
SQL Server
creating arepository for, 72
stand-alone client
System Requirements, 27
starting
Hyperion Analyzer, 51
Hyperion Analyzer server, 51
Hyperion Essbase OLAP Server, 50
RDBMS services, 50
starting and stopping
Apache Tomcat Application Server, 51
System Requirements
client, 28
server, 25
stand-alone client, 27
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uninstalling
from UNIX, 79
Hyperion Analyzer from UNIX, 79
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